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From Drone to CAD
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Objectives

» Understanding of Field Procedures for both Photo and Lidar Drone Projects

» Types of Drones — Review types as well at the all important ‘Payload(s)’
» Workflow of producing deliverables from Drones (Photo/Photo-Lidar/Lidar Only)
> Explore the options within Point Cloud Data — Feature Extraction = Into CAD

> Project Setup and Settings to best utilize Field To Finish Projects for both the Field
and Office with Carlson Software — Into CAD

» Explore and Learn the Feature Extraction Options within Carlson Software

1/5/2026
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Objectives

Yes, learning can be fun....
Let's make that a Goal of Today!
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Setting Up...

Field Procedures 101

Targets:
- Easy to See

- Can be ‘Home Made’
- Contrast in ‘Key’
Spread Out
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Mission Planning
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Mission Planning Options:
* Waypoint

 Rectangular

« Polygon

« Oblique

* Slope

Key Parameters:

+ Altitude (AGL or MSL)

« Front and side overlap percentages
« Flight speed

« Camera angle

« Gimbal pitch

I‘ Carlson.
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Planning a Rectangular Mission

Steps:
«  Open Autel Explorer and select "Mission."
+  Choose "Rectangular” mission type.
«  Define the area of interest by adjusting the rectangle on the map.
+  Set mission parameters: altitude, overlap, speed, camera angle.
* Save and name the mission for future use.

Tips:
«  Use 75-85% front overlap and 70-75% side overlap for optimal

results.
+  Adjust flight speed to 8-12 km/h to prevent motion blur.
* Set camera angle to 90° for nadir (downward) images.

SET A SES SES SES SRS S S8




GROUND

@ Carlson
Executing the Mission

Pre-Flight Checklist:

« Ensure batteries are fully charged.

« Verify sufficient storage on the SD card.

» Check GPS signal strength.

« Calibrate compass if prompted.

« Confirm weather conditions are suitable for flight.
* Check RTK

During Flight:

* Monitor live feed for image quality.

+ Be prepared to pause or abort the mission if necessary.

* Maintain visual line of sight (VLOS) with the drone.web.carlsonsw.com
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Proper Field Operations for Drone
Mapping Missions

Purpose:
* Ensure accurate, repeatable mapping

* Minimize re-flights and processing errors
« Align drone data with survey-grade control

Key Components:

* Mission planning

* Ground Control Points (GCPs)

¢ Check points

* Proper placement & documentation

@ Carlson.

GROUND

What Are Ground Control Points
(GCPs)?

Definition:
* Known surveyed points used to georeferenced drone data

Why GCPs Matter:

* Improve absolute accuracy

* Reduce GNSS drift

* Support engineering-grade deliverables

Survey Requirements:

* RTK/PPK or total station
¢ Clearly visible

* Stable and undisturbed
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Types of Ground Control Targets

* Painted targets, Spray Painted X with a Mag Nail.
* Fabric or vinyl targets (reusable)

* Plastic or aluminum panels (semi-permanent)

* Natural features (limited use)

* Permanent Painted Lines, Roadways, Parking Lot Lines,
Tips of Painted Arrows.

Best Practices:

* High contrast

* Size matched to flight altitude

* Flat and level, Unobstructed Views

1/5/2026
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Proper GCP Placement Strategy

Even distribution across site
Place near corners, edges, and interior
Avoid clustering or single-edge layouts

Typical Counts:
<20 acres: 5-7 GCPs

20-100 acres: 8-12 GCPs
Large sites: increase proportionally
Often with RTK drones, Less GCPs are required.

orld 2010.
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Check Points vs GCPs

Check Points:
» Surveyed but not used in processing
* Validate horizontal and vertical accuracy

Best Practice:
» 20-30% of total points as check points
* Similar distribution to GCPs
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LiDAR vs Photogrammetry — Field
Thought Process

Photogrammetry:

* Image quality and overlap are critical

¢ GCPs drive absolute accuracy

* Sensitive to lighting, shadows, and surface texture
* Visual clarity is essential

LiDAR:

* Sensor calibration and trajectory accuracy matter most
* Fewer GCPs often required

* Penetrates vegetation

Key Difference:

¢ Photogrammetry is image-driven

« LiDAR is trajectory-driven

1/5/2026

13

[© Carlson.

Drone Platform: Entry-Level vs Heavy-Lift

Entry-Level Photogrammetry Drones:
- DJI Phantom / Mavic series
- Autel EVO Il series

Heavy-Lift Industrial Platform:
- Carlson CRD1
- Others within the industry...

These platforms are designed for very different missions,
workloads, and long-term use.
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Entry-Level Photogrammetry Drones

* Designed for simplicity and speed:
- Integrated fixed camera
- Lightweight and portable
- Quick setup, minimal training
- Lower upfront cost

* Best for orthomosaics, stockpiles, and small
construction sites
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Limitations of Entry-Level Drones

- Camera-only payloads

- Limited flight time with accessories
- No LiDAR or specialty sensors

- Limited upgrade path

- Performance affected by wind and complex
environments

1/5/2026
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Heavy-Lift Platform

* Designed for professional survey and scalability:
(Hardware Example — Carlson CRD1)

- Modular payload system

- Supports LiDAR, large cameras, specialty sensors
- High power propulsion and long endurance

- Built for repeatable, survey-grade results
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Payload & Capability Comparison

* Entry-Level Drones:
- Fixed camera
- Photogrammetry only
- Limited payload capacity

* Heavy-Lift Drones:
= Interchangeable payloads
- Photogrammetry, LiDAR, bathymetry, etc.
- High payload capacity and flexibility
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Operational & Business Impact

* Entry-Level Platforms:
- Great starting point
- Often replaced as needs grow

* Heavy-Lift / Scalable Drone Platform:
- One platform, many missions
- Lower long-term cost of ownership
- Scales with your business

1/5/2026
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FCC Drone Action — What You
Need to Know

Clarifying facts and impacts for
customers and sales teams
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@ Carlson
Background Context

* The drone industry has raised concerns about
Chinese-made drones for several years.

* Primary concern: potential transmission of
collected data back to China.

* U.S. agencies required a security audit by a
qualifying U.S. authority.

* The audit deadline passed with no qualifying audit
completed.
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What Happening Now

* The FCC has acted following the missed audit
deadline
* The FCC (not the FAA) has restricted new
approvals.

* New makes and models of CCP-associated drones
are now blocked from certification.

1/5/2026
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What the FCC Covered List DOES NOT Do

* Does NOT ban the use of existing drones.
* Does NOT ground any current drone fleets.
* Does NOT affect resale or operation of previously
authorized drones.
* DJI, Autel, and other foreign-made drones already
certified remain legal to fly.
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Practical Impact (Forward-Looking)

* No new certifications for additional foreign-
made drone models or radio components.
* Federal authorization would be required for future
approvals.
* Parts availability and long-term platform support
may become more limited over time.
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What Is NDAA Compliance?

* NDAA = National Defense Authorization Act.
* Focuses on secure supply chains and trusted
manufacturing.
* American-made or allied-country components are
acceptable.
* Example: Japanese components = acceptable;
North Korean components = not acceptable.

1/5/2026
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What This Means for Customers

* If you already own an Autel or DJI, etc.

* You can continue flying legally
* Previously delivered systems are not affected.
* There is no immediate operational disruption.
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What This Means for New Purchases

New procurement decisions should prioritize
'NDAA Compliance'

* Consider long-term supply chain stability.

* Evaluate manufacturer support and regulatory risk
going forward.
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Other Technology...

Mobile Mapping
And Handheld LiDAR
+SLAM
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Features

One-Button Operation
Automatic Antenna Lever
Arm Offset Estimation
One-Click Raw Processing
Batch Processing

Advanced Point Cloud Filters
What You See Is What You
Get

Full Boresight and
Calibration Tools

Carlson.
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Mount Antenna

Ensure that the antenna(s)
is/are securely and properly
mounted on the vehicle in an

area with good visibility of
the sky.

1/5/2026
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SLAM - Simultaneous
Localization and
Mapping

Laser SLAM uses LIDAR

sensors to capture 3D point
clouds of the environment.
SLAM is best for use in GPS
denied environments

Carlson.
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LiDAR Backpack

Internal Battery Power

Handheld
Can be used with GNSS
SLAM capable
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Drone Platform: Summary...

Each Drone ‘Type’ has it’s Individual Purpose

Depending on the scope of your job you may need
more than one type or style of drone classification

Partnering You With the World 2010.
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Now what to do with all of that
‘Drone-Data’ you've collected...!!!
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Processing the ‘Data...’

LS5

N
a2
A

24 \ e
SA R\
}\:‘1 \ \ § \.” g
L&) Carlson'
- - et
®a” PhotoCapture
35
@ Carlson.
Flexibility
VF £ gg!c‘iﬁﬂ 1
. Released in
iiljlazg(ién July 2021
Cloud-based
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Key differences

based

Clo

* No need to use a powerful PC

* Pay only when you need it

* Process and access your data anytime,
from any device

 Share your data with stakeholders,
partners, or the entire world

* All your data is safely and redundantly
backed up

* Works without high speed
internet

* Permanent license

* Compliance with security
regulations

* Unlimited volume: process as
many projects as you need

37
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How it works

UPLOAD YOUR IMAGERY
Choose your project

various other settings. °% .

Upload or add your imagery :

to Carlson Photo Capture
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ADJUST GCPs (OPTIONAL)

I‘ Carlson.

Use our intuitive ground control adjustment
process to deliver high accuracy.

RECENT UPDATE —
GCP AUTO-DETECTION

39
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VISUALIZE, ANALYZE, SHARE

Explore finished products. Create new data with
Survey Canvas. Export data to other Carlson
software products for design, mapping etc.

I‘ Carlson.

Digital Elevation Models

Volumetrics
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seescnew cnovne Did you know that CPC is
available from Carlson Office?
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carlsonphotoca pture.com.

(&)Garison Wome  HMowlWoks  Festues  Pchg  InterciveDemos  LocateDealers

* o
a8 xeuxsw

Carlson Photo Capture processes your images

into 3D data at unparalleled speed and Scale”

START FREE TRIAL

EXPLORE DEMOS

1/5/2026
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Drone flight in Krakow

@ Carlson.

Time for discussion...

- Still an Emerging Technology
- Find the product that works best for you
- Carlson is not the only option...

But... we’d enjoy having you as a customer ©
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Getting Started with...
Carlson Point Cloud Advanced
45
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Carlson Point Cloud
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Start a new project

& Pont Cloud Advanced (Dec 26 2024} =
Project | Scene | Camers | Aetion | Dats |
3 .
- i w0
boen Close Swe Swweds BOM CBC Setwp Help Ext

Current Project

Enter name and linear unit. Defaults to drawing unit

& New Point Cloud Project x
Focer [P —
et Name sn
— P <
e (TN <]

o canca
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Project Page

« Upper toolbar
« Project tree
- Outlines all entities in
the project
> Most data is in
“Processed Data” folder
« Command History
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Import a Point Cloud

Clouds must be imported to an
internal format “bxyz” before
use.

DIAgo@®a:

On the project page right-click
the Clouds folder and select
import. Then select the type of
file to import from the
available options

LAS/LAZ, E57 and Scan3D are
the most common Exportto LAS

DEMVESRS [ domy/.ad.anc
GeaTF L047100)
PCG [peg]

RCS fres

i 8 gt

Caruan Cosrsinate. [ord
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8 impont Dane Pt Cioud x

Import a Point Cloud

e Import File information: WKT
string saved with the file if
available

e Set name for imported file

o Select Orthomosaic if available

o Used with certain actions

e Change projection (optional)

e Set Linear unit ==

e Resample or Remove duplicates
(optional)

o If point cloud has 500 million+
points “Remove duplicated
points” will be on by default iy s ol

- Deteted U Sumvey Faet i

1/5/2026
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View the Point Cloud
<Cloud to view>->Right-Click->View
Create Scene Dialog

« Select Color Mode
« Set Rendering options
« Set Projection mode

1/5/2026
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Requires a scene
viewer window open

Scene Page

« Scene Entity tree
« Click on entities in tree for
specific controls and settings
- Hide/Show
> Color Mode
- Point Cloud Classifications

53

@ Carlson

Requires a scene
viewer window open

Action Page i o mem e

« Selection —

« Point Cloud Editing and
Transformation

. Create entities

« Extract features

54
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Point Cloud Clean

« Project Tree->Right-click
cloud->Clean

« With a scene open with the
cloud:

Action Page-> Edit->Clean

1/5/2026
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Point Cloud Clean

« Remove Duplicated Points - Results
in the point cloud have
approximately even spacing of
Distance Threshold

« Remove Isolated Points - can remove
small clumps of points

« Remove Redundant Points -
decimates point cloud for surface
model creation (least common).
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Point Cloud Transformations

« Project Tree->Right-click -
cloud->Transform

« With a scene open with
the cloud:

Action Page-> Transform

57
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Point Cloud Transformations

« Scale - Quickly scale between common units such as US
Feet and Meters

« Elevate by Geoid or offset - Changes elevation of all
points

« Change Projection - Transform from one projection
system to another.

o Must know the current point cloud projection and target
projection

« Transformation Wizard offers advanced options for

scaling, offset and rotation by matrix.

1/5/2026
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Making a selection

« By perimeter polyline
« Byrectangle

« By sphere

« By color
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Selection Actions

Hide

Delete

Create new entity

Classify - from Scene Page with a cloud selected in the
tree

« Use with supported extraction routines

o Bare Earth

o Building

Contours
Paint Lines

60
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Field to Finish

Carlson Point Cloud Module

1/5/2026
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Create Point Panel .

Available from Action Page-
>Create->Point

Allows for placement of
Coordinate points with Field
to Finish codes
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F2F Code Setup

o Setif points will be added to
CRD point list (most common),
control point list or scan position
list

o Designate starting point number

o Set F2F code in description box

o Increment point number or use
custom settings

63
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F2F Code Setup

« Code button allows setting a code from FLD file

d

1/5/2026
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Manual Drafting

65
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How to access
Action Page->Create->Point->Manual

66
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Create Point Entity

« Use Point Entity
code

« Select “Add” Pick
Point Action

« Click on point in the
cloud to place CRD
point

1/5/2026
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Create Polyline Entity

e Use a Polyline Entity

code

e Select “Add” Pick
Point Action

e Click on points along
feature. A polyline
will be drawn as
points are picked

e Special codes for
Begin and End are
added automatically.
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Point Editing

« Select “Edit”
pick point
action and click
on crd point

« Edit parameters
as needed

« Screen Pick
allows for re-
pick of point

-
& Edit Coordinate Point

Coordinate Point

Name:

4

Description:

_Bl

X Y Z
735503.414  2958567.865 20.338

Screen Pick  |All >

oK Cancel Help

69
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Shortcuts —

P,

« E key to end current polyline
« Cto close current polyline
« Right-Click
o Undo
o Edit
o Remove
o Move
« Shift Right-Click
o Point Filters
o Snap Types

1/5/2026
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Tree and Pole extraction

71
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How to access

Action Page->Create->Point->Features or by clicking
the Tree or Pole icons in the Scene View Window

LOoNrt+l BPPEPz 2 A

72
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Requirements

Tree trunk and canopy captured
Extraction is possible

Point Cloud must have the Poles, Tree Trunks and
Canopies captured well for extraction to work

No tree trunk captured. Cannot extract

1/5/2026
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o All Feature options
o Hide points
o Add to classification
o Draw Solid
o Draw perimeter

Extraction Options - Options Button

4 Feature Recogrinen Settings x

Hide Feature Points
44 Points Ta Classiiatbion

o Entity specific parameters
o Max Diameter properties need
to be tuned for best results
o Set a Description or Code per
entity

opy Dismeter 1) a0

on Tiee

ox Cancel
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Point Description
Descriptions include

« Feature type
« Height

« Diameter

o Lean

. Tree type

75
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Extract a pole or tree

e Locate a pole or tree with
the trunk or base of pole
well defined and isolated

e Click on the base of the pole
or trunk 6-24 in from the
base of the ground

e |f extraction fails, read
warning in command history
and adjust pick position or
parameters. Edit extracted
feature if necessary.

1/5/2026
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Edit a Feature Point

Press “Edit Existing Feature” and
click on feature point

Can adjust

Bottom/Top positions
Diameters

Lean

Tree Type

etc

77
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Feature Extraction
Carlson Point Cloud Module

78
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How To Access

« Action Page -> Extract

« Scene View Window -> Feature
Extraction

« Scene View Window ->
Classifications

LA OWC D24

1/5/2026
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Feature Extraction from the Action Page

. Bare Earth

« Contours

« Volumes

« Power Lines

« Building Outline
« More...

80
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GROUND

Bare Earth

e By Expansion Method
o No parameters
o Can extract direct to TIN
o Works best for terrain with gradual slopes
o Cloud Linear Unit must be accurate
e By Grid
o Use if Expansion gives poor results
o Set Cell Size to minimum 5x the average point
spacing in the point cloud
o Increase Cell Size if the point cloud has a large
area and extraction runs slower than desired. ool Nt
e By Profile
o For use with Ground LIDAR scans.
o Typically not needed over other methods

81
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Bare Earth By Expansion Example
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Contours

« Create contours at regular
interval or at a specific
elevation

« Option to add Index contours

« Uses intermediate TIN which
can be simplified as needed

83
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Contours

can be drawn to CAD

Contours appear in the project tree where they

28
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Extract Volumes

Draw a Polyline using
the Create Polyline
Panel surrounding the
mound

Set Extract units
Optionally extract Tins
used for calculation
Screen Pick the Polyline

& Extract Volume X

Cut: 07CY Cut Area: 23.3 SY
Fill 54682 CY Fill Area: 1279.8 5Y

Continue Cancel

1/5/2026
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Extract Power Lines

Detection Modes

3-Point solves Catenary
curve from 3 screen picked
points

1-Point follows wire points
from one screen pick
1-Point Draw all works same
as above but also looks for
nearby parallel powerlines
in the search radius

Current Action

Extract Power Lines
Polyline Layer
Detection Mode
Draw All Search Radius

Find Power Line

Powerlines

[3 Point

Undo
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Extract Power Lines

3-point mode is best
when the wire is not
captured in the point
cloud well

1-point require the
wire be well captured
in the cloud to follow
accurately.

87
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Extract Buildings

e Extracts rough polylines of building
footprints, calculates approximate areas and
heights

e Recommended to use “Single By Wall” for
cloud made with ground lidar. Requires
clicking on a wall e

e Recommended to use “All Buildings” for
other cases.

o Works with Selection e

e Set Minimum Wall Height above height of -
fences for better results -

1/5/2026
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Extract Buildings

Extracted outlines are
numbered with floor
count, height, and rea

A Building_Outline 1-1-10-2280
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Feature Extraction with Cloud and
Orthomosaic Image

« Parking Lines / Paint Stripes
« Curbs
« Smart Classifications

These routines utilize Machine Learning
techniques to detect features. Send us your
datasets to help us improve the detection!

90
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Parking Lines / Paint Stripes

e Paint lines - Extracts all paint
lines including road lines

e Parking Lines - Extracts parking
lines only as 3-point polylines

e Recommended to use Auto
Detection mode which
requires orthomosaic image.

e Use Selection Mode if
orthomosaic is not available.
Requires paint points be
selected well

91
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Parking Line Editor 3

Access from Line Editor button """ L aas
on Parking Line extraction rini i ¥ i
panel e i B
« Create new 2 e

« Fillin missing

« Edit existing

« Review low confidence Fain Mg Lo
parking lines Enr

Active Uine Narme:

Use arrow keys 10 rotate and adjust the length of the selected fine

o
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Tt W Seedwd 16 Mo

I‘ Carlson.

BREAK NEW GROUND

tesd e Savw s
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Parking Stall Counting

« Requires polylines from Parking Lines routine
« Counts stalls in between parking lines

« Manually edit spaces as Standard or Handicap
« Visualizes parking stalls with colored markers

93
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“Curbs” on the action page is
legacy routine.

Curbs

Use Feature Extraction drop down -> Curbs.
Requires Orthomosaic Image

Detects the base of curb line and then offsets the
line to create top and back of curb lines

Classifications ~ Feature Extraction  Feature Com

aQae Parking Lines I&

Paint Stripe

Curb Settings.
Curb
Trench

Help

94
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Curb Settings

Access from Feature Extraction
drop down menu -

> Curb Settings...

« Set Layer names

o Enable/disable back andtop |
of curb offset polylines o

« Set horizontal and vertical
offset values

95
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Access from Feature Extraction
drop down menu —

Road Edges

> Road Edges...

e Set Layer names
e Send To CAD
o Polylines Category = Road Edge

. mm.e0a

96
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Smart Classifications

Access from Classifications
drop down menu -> Smart

Classifications from Image { & Carlson Digital Twin: Smart Classifications X
Set Classifications to extract [ Classification — E
oM el s
Sets color more to Concrete B
classification for Masonry (-]
visualization of results Gravel (]

Foliage -]

Grass (-] -

|8 Clear Existing Classifications

oK Cancel
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GROUND

Smart Classifications

Gt Classiteabions| Coior Mo
1D # hide Select] . hame | _Color |
0 Created/Default |
64 Pavement

Masanry

67 Gravel

[T Follage

&9 Vehicles
71 Grass

73 Bare Earth
75 Vehicle

@ Carlson.
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SESSION
EVALUATION

HTTPS://WWW.SURVEYMONKEY.COM/R/PSLS2026EVAL
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